
6.1.0 New Features

There are four new features in 6.1.0

• 'Discounts' option in 'View' menu
• 'Troubleshooting' menu option in 'Help' menu
• 'Export Froogle Date Field' option in 'File' menu
• Integration with PayPal, in 'Business Settings | Payment and Security'

US customers also get a new-look interface to UPS Online Tools.

Setting Discounts Based on Order Total

Go to 'View | Discounts…'

This screen is used to create discounts for your customers based on the total amount of
goods in their shopping cart. In other words, based on the total amount they have
spent.

The top grid is used to set up which discounts are enabled, how they are applied, and
what are they applied to.

Field Description
Enabled Tick this box to enable the discount.
Description Enter here how you want the discount to be described in the

customer's shopping cart online.
Type Is the discount applied as a sum of money (e.g. save £10.00 if you

order above £100)
Based on Select whether you want the discount to be applied based on the

value of the cart contents including or excluding tax. If you want it



to be including tax, then you can choose between applying it on
the 'default' tax value (applied to all customers as they start
shopping) or on the 'actual tax' value - which will be worked out
in the final stage of the checkout.

Once you have set up these, you can start working on the 'Discount Triggers' - the
conditions that which will cause these discounts to be applied.

Field Description
Cart Value Within this column, enter the minimum amount to be spent before

the discount will be applied.
Amount The cash amount that will be taken off the order if a customer's

spending matches or exceeds the 'Cart Value' figure.
Percentage The percentage that will be taken off the order if a customer's

spending matches or exceeds the 'Cart Value' figure.
Surcharge Tick this box if you want the amount to be added to the order as a

surcharge, rather than taken away as a discount.

You can create multiple rows within this grid to create several price breaks. For
instance, if you wanted customers spending £100 or to get 5% and those that spend
£200 or more to get 10% then you would set it up as shown below., or as a percentage
of the amount spent by the customer (e.g. save 15% if you order above £100).

PayPal Integration

PayPal is available in 6.10 in the list of Payment Service Providers. It is set up and
configured in the usual way (i.e. you select it, enter your merchant ID and upload).



Exporting - Froogle Data Feed

Actinic Ecommerce has the ability to be able to export your store data as a 'Froogle
Data Feed'. This is a special format of data, designed to be read into the online
shopping engine at http://www.froogle.com/.

The data is saved as a tab-delimited text file on your PC. You will then need to register
at http://www.froogle.com/ in order to be able to add your shop data to Froogle.

More details can be found online at http://www.froogle.com/.

Troubleshooting Menu Option

If you go to Help | Troubleshooting you will see the following screen:



This window contains a wide variety of tools to help you diagnose problems on your
PC and on your web site, and also correct issues on your online store. These tools are
not designed for Internet novices - many of them are very advanced and are normally
only used in discussion with Actinic Technical Support or with the person that sent
you the software.

The tools here are described below:

Field Description
View Error Log Actinic can create an online log file of all errors encountered at the

online store. This file is called 'error.err' and will be created within
your 'acatalog' folder online. By clicking this button, you will open
this file in a browser window. The most useful data is towards the
end of each line where you will see a data and time, and the error
encountered.

This button will be enabled once you have uploaded your store for
the first time.

Remove Error
Log

If you have a very large error.err log file at the web site, it may be
useful to remove it so that any new errors will be listed in a brand
new log file.

WARNING:  Only do this if you are absolutely sure there is no
useful information in the existing error.err log file - as there is no
way to get it back once it is deleted.

Web Site
Analysis

Sometimes, it is useful to see a more in-depth and technical
description of how suitable your web site is for running an Actinic



store. By clicking this button you will launch the 'Web Site
Analysis' where Actinic will test whether Perl is installed, whether
the permissions are correct, and what files have been uploaded.
The results are highly technical and not designed for people that
are relatively new to the Internet.

Purge Session
Files

If customers are having problems placing orders, or if you are
transferring a site from one server to another, you may want to
manually end all current shopping sessions on your online store.
By clicking this button you will remove all 'Session Files' from the
website, which will effectively empty all shopping carts in one go.

WARNING: Only do this if you are absolutely sure you need to
do this as it will interfere with customers currently at your site.

Order Number Every time an order is placed at your store, a sequential number is
added to the end of the order number (starting at '1' for the first
order placed). This field tells you what the online store thinks the
current order sequence number is - and the next order placed will
be one higher. Click 'Query Order Number' to ensure that this
field is showing the most up-to-date number.

Query Order
Number

Click this button to make the 'Order Number' field display the
current order sequence number from the web site.

Update Order
Number

Use this button if you want to manually override the current order
sequence number at the website. Enter a new number in the
'Order Number' field, and then click this button to change the
number at the website. The next order placed will be one order
sequence number higher.

WARNING: Only do this if you are absolutely sure you need to
do this as this can cause unaccountable gaps to appear within
your ordering numbering sequence.

Compare Perl
Scripts

Click this button if you want to see which Perl Script templates in
your site folder have been manually edited. It will compare the
Perl files in your site folder with the Perl files in the 'Original'
folder and display the results as a list of template names.

Compare
Templates

Click this button if you want to see which HTML templates in
your site folder have been manually edited. It will compare the
HTML templates in your site folder with the same files in the
original theme folder. The results will be displayed as a list of
template names.

Version of
ActinicCatalog.
mdb

This field will tell you what Microsoft Access version your Actinic
database (ActinicCatalog.mdb) is in.

Run
ActDiagnose

'ActDiagnose' is a simple application which looks for all the
Actinic-related information about your PC and lists them in a
format that can be copied to an email. You can use this if you are
having problems on your PC and you want to send details of your
PC to someone.

Export Support
Snapshot

A 'Support Snapshot' is standard snapshot, but with all the credit
card numbers replaced with random characters. If you want to
remove all other customer details from the snapshot then check



the 'Remove name, address, phone and fax details' checkbox.
Remove name,
address, phone
fax and email
details

Check this box if you want to create a snapshot which includes no
personal details about customers that have bought at your store.
You then need to click 'Support Snapshot' to create the snapshot.

Significant Bug Fixes and Improvements

When installing a maintenance release, all sites are automatically snapshotted by
Actinic Ecommerce before they are upgraded. This allows fallback to previous release
and facilitates the diagnosis of upgrade problems. Ref: a_c/967
Actinic now backs up your current design when applying a new theme. This is saved
as a backup theme within 'formats/auxiliary/themes'. Ref: a_c/997
The error messages received during a Network Settings test are now more meaningful
and hopefully helpful. Ref: a_c/859
UPS Online Tools Interface changed to work with new XML-based interface. Ref:
a_c/873
'CSS Files' button has now been added to the graphical template navigator. Ref:
a_c/924
Default date shown online for the date prompt now defaults to today's date. Ref:
a_ss/234
A 'text only' and a 'text and title' product line template are now available. Ref: a_c/905
'Order Manager' navigator is now available when using Actinic Order Manager. Ref:
a_c/939
It is now possible to manually update the order sequence number, generated by
order.num on the website. Ref: a_c/995
Logged in buyers no longer have duplicated framesets when they follow section links.
Ref: a_c/987
Any links embedded as HTML within a brochure fragment on the front page of the
store will now display correctly (rather than be wrongly prefixed with the Catalog
URL) Ref: a_c/849
Error message received when an order is downloaded into an older copy of Actinic
than the one that was used to build the site is now improved. Ref: a_c/848
The fields for 'Prompt' and 'Message' in the tax exemption area are now the right way
round in order to display correctly online. Ref: a_c/846
The 'rollover' code for the brochure navigation buttons will now always find the
images within the 'acatalog' folder online. Ref: a_c/933
Loophole closed whereby customers are in the checkout, and then hit back a lot to add
something else to the cart, and then go forwards and checkout – producing an order
with no customer details. Ref: a_c/985
Actinic no longer forces a 'Refresh' when the clocks change due to daylight saving
time. Ref: a_c/998
'Recalculate' button removed from 'Shipping and Handling' tab in the order details
window as it is not necessary. Ref: a_c/970
Customer messages were not appearing to non-logged-in customers when the 'Retail'
price schedule was disabled. This is now fixed. Ref: a_c/969
Error that refers to having duplicate copies of  'Act_SecPayOK.html' file when



upgrading from v4 to v6 has now been fixed. Ref: a_c/966
An import will now no longer remove customer property values that are defined within
'Design Options | Site Defaults'. Ref: a_c/964
'Back to Top' link in 'Funky' and 'Curves' themes have now been fixed to work
correctly on sites with logged-in customers. Ref: a_c/942
When Brochure ran in a custom frame, the frameset was being removed when the
customer entered the store. This has now been fixed. Ref: a_c/951
The default pop-up window template is now 'Name and info text displayed below
image'. Ref: a_c/904
When main order line is hidden, the quantity box now appears by the component (as
long as there is only one component). Ref: a_ss/264
Products that have been deleted from the online store now appear within the Sales
Analysis reports. Ref: a_c/955
There is no longer a chance of creating an order with no details by clicking the 'back'
button in the browser during the checkout. Ref: a_ss/262
Email address field can now support 255 characters Ref: a_c/903
Order download button will no longer appear greyed out if there has been a design
upgrade but not a version upgrade. Ref: a_c/884
Actinic will now start without an error message if the brochure template ini file is not
found within the Site folder. Ref: a_c/883
Extra cell no longer appears at the end of component row in the shopping cart when a
component is listed as a separate order line. Ref: a_c/900
When you change sites, and select to do a site snapshot, Actinic Ecommerce will now
always carry out the site change after the snapshot has finished. Ref: a_c/916
The 'add to cart' errors were appearing twice within the Act_ProductLineTable
template. This is now fixed.  Ref: a_c/868
The menu items in the 'Funky' theme have been changed so that they work with all
colour schemes. Ref: a_c/864
Unregistered customers can no longer browse the site if you have selected the store to
be closed to unregistered shoppers in 'Business Settings | Ordering'. Ref: a_c/949
'No order line for main product' is always un-ticked now when you remove
components from a product. This means that there is no way for no short description to
be shown in the shopping cart. Ref: a_c/9458
The time zone has been added to the customer receipt email. Ref: a_c/944
The price explanation fields in the 'Act_VariantComponentName.html' template are
now completely hidden when a customer is not logged on. Previously, people had been
getting a large gap appearing within the HTML. Ref: a_c/926
When you upgrade from an earlier version, the login button used will now be the one
from your currently-selected theme. Ref: a_c/909
When you click the 'Mail' button on a particular tab, the correct email template is now
displayed by default. Ref: a_c/914


